TaxPro Forms Version 5 Changes and Enhancements

TaxPro e-TDS Professional Version 13 Changes and Enhancements

Enhancements in -- Version 13.5.2 -- Release Date 07/11/2013

Changes made in PAN Verification from TRACES in Deductee Master
Option given for Export to Excel in Deductee Master

Filter given in Deductee Master for All, PAN Verified and PAN Not Verified.
In Form 26Q, 27Q and 27EQ Section Wise Filter added.

Enhancements in -- Version 13.5.1 -- Release Date 10/10/2013

* Population of Alternate Email ID and Alternate Telephone from Authorize Person Details Master . Also come
after clicking Fill from Master given on each Form 24Q/26Q/27Q/27EQ

* Updated Nature of Remittance List in TDS Annexure column of Form 27Q.

* |n Form 27A - Setting 'Preview / Print in Portrait Format' will save as per the user selected.

Enhancements in -- Version 13.5.0 -- Release Date 26/09/2013

* Updated FVU Version 4.0 and 2.136
* Provision for Form 24G - Revised is now available in s/w.

Enhancements in -- Version 13.4.8 -- Release Date 23/08/2013

* Changes made in case of Revised Form 24Q for FY 2013-2014 where the Challan is added in revised and /
or deductee added in TDS Record.

Enhancements in -- Version 13.4.7 -- Release Date 13/08/2013

* Updated Preview/Print facility in Form 27EQ & Form 27Q FY 2013-14
* Updated New FVU Version 3.9 and 2.135

» Key feature of FVU version 3.9
 Change in validation of quarterly TDS/TCS statements are as below:

Book entry flag should not be provided in the challan details for nil challan\nil transfer voucher
for all the financial years.

In the salary details (Form 24Q Q4 — Annexure Il), if PAN provided is invalid (i.e.PANNOTAVBL,
PANAPPLIED & PANINVALID), then the flag in the column
“Whether tax deducted at higher raté’ mandatorily needs to be “Yes” for TDS statements
pertaining to FY 2013-14 onwards.o Mandatory to mention at deductee details “Country of
Residence of the deductee” in TDS statement (Form no. 27Q only — Regular and Correction)
pertaining to FY 2013-14 onwards.

» Change in name of the field of : In the deductee details (Form 27Q — Annexure 1), name of the
field “Country to

which Remittance made’ has been changed to “Country of Residence of the Deductee”. In the
deductee details (Form 24Q — Annexure 1), name of the field “Taxable

amount of which tax deducted’ has been changed to “Amount paid/Credited”.

Page 1



TaxPro Forms Version 5 Changes and Enhancements
e FVU version 3.8 and 3.9 are applicable uptoAugust 31, 2013. Further, FVU version 3.9
would be mandatory from September 01, 2013.
Key features 2.135

 Change in validation of quarterly TDS/TCS statement wherein “Book entry flag” should not be
provided in the challan details in case of nil challan\nil transfer voucher.

* Change in name of the field of as below: In the deductee details (Form 27Q — Annexure 1),
name of the field “Country to which Remittance made” has been changed to “Country of
Residence of the Deductee”.

o In the deductee details (Form 24Q — Annexure 1), name of the field “Taxable Amount of which
tax deducted” has been changed to “Amount paid/Credited”.

* FVU Version 2.134 and 2.135 are applicable up to August 31, 2013. Further, FVU Version 2.135
would be mandatory from September 01, 2013.

Enhancements in -- Version 13.4.6 -- Release Date 05/08/2013

Updated Preview/Print facility in Form 24Q FY 2013-14

Enhancements in -- Version 13.4.5 -- Release Date 23/07/2013

Changes made for sending request for Form 16, 16A Consolidate File for FY 2013-2014

Enhancements in -- Version 13.4.4 -- Release Date 18/07/2013

Updated generation of Form 16A from Form 26Q for FY 2013-14
Updated generation of Form 27D from Form 27EQ - for FY 2013-14
Updated Form 26Q - Preview and Print for FY 2013-14

TDS Template Updated for FY 2013-14 (Download Latest Template )

Enhancements in -- Version 13.4.3 -- Release Date 11/07/2013

Changes made for e-TDS Revised Return

Enhancements in -- Version 13.4.3 -- Release Date 11/07/2013

Changes made for e-TDS Revised Return

Enhancements in -- Version 13.4.2 -- Release Date 06/07/2013

In New Form 24Q, 26Q , 27EQ and 27Q- Resolve the Error 424 -Object Required - on Inserting New Row on
Scroll Down Key

In Revised Return for Form 24Q following Error during

C5 - PAN Correction Taxable Amount of current employer - T-FV-4317 No value to be provided.
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T-FV-4064 Invalid Salary Detail Record Length

Enhancements in -- Version 13.4.1 -- Release Date 05/07/2013

Following Error Resolved in Generating FVU File for FY 2010-11 and 2011-12 including Nil Return.

* T-FV-3162 No value should be provided. for Fees Field
* [nvalid Salary Details Record Length

Enhancements in -- Version 13.4.0 -- Release Date 05/07/2013

* Changes made relating to New FVU 3.8 and 2.134
* Following are the Database Changes for user information.

Table- Challan

Following Column Added
Fees - Double

Table - TDSAuthority

Following Column Added
PRAIREmail - Text 150
PRAItPhone - Text 150

‘Table - [NonSalaryTDS Transaction]

Following Column Added
CertificateNumber - Text 75

Table Name - [SalaryTDS Transaction]

Following Column Added
CertificateNumber - Text 75

Table - [NonSalaryTCS Transaction]

Following Column Added
CertificateNumber- Text 75

'Table - [NonResidentTDS Transaction]

Following Column Added
CertificateNumber - Text 75

'Table - [Form 26Q Challan Details]

Following Column Added
Fees - Double

'Table - [Form 24Q Challan Details]
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Following Column Added
Fees - Double

'Table - [Form 27EQ Challan Details]

Following Column Added
Fees - Double

'Table - [ChangeForm27QChallanDetails]

Following Column Added
Fees - Double

Following New Table Added

Form24QChallanDetails
Form24QMain
Form24QSalDetails
Form24QTDSDetails
Form26QChallanDetails
Form26QMain
Form26QTDSDetails
Form27EQChallanDetails
Form27EQMain
Form27EQTCSDetails
Form27QChallanDetails
Form27QMain
Form27QTDSDetails

Key feature of FVU version 3.8

Change in data structure of quarterlyTDS/TCS statement pertaining to FY 2013-14 onwards as below:

o Alternate contact details like e-mail and contact no. of theleductor and responsible person
may be provided.

o Quoting of TAN registration no. (if any) as provided by TIN.

o Minor head code is to be provided inchallan details.

o Late fee is to be provided inchallan details applicable from FY 2012-13 onwards.
o No details to be provided forcheque no. and section code in the challan details.

o Section code to be provided indeductee/collectee details.

o Introduction of new section code Form no. 24Q: Section 92C has been added which is
applicable in case payment is made to Union Govt. employees.

o Section 1941 has been bifurcated as below:

= Select value 4IA from the section code drop down where tax has been deducted
under section 1941 (a)

= Select value 4IB from the section code drop down where tax has been deducted
under section 1941 (b)

o Lower/ No deduction certificate no. to be provided in thedeductee details.
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o In the annual salary details (24Q, Q4— Annexure II) break up to be provided for the salary
paid and the tax deducted by the current employer and previous employer during the
current Financial Year.

o Introduction of fields for quoting foreign remittance details in Form no. 27Q as below
* Nature of remittance
* Whether TDS rate of TDS is IT act (a) and DTAA (b)
» Unique acknowledgement of the corresponding form no 15CA (if available)
= Country to which remittance is made

o Introduction of value*“Z” in the field Remarks for lower or no deduction. Applicable in case
of no deduction on account of payment under section 197A (1F).

o In the annual salary details (24Q Q4— Annexure II) records to be highlighted whether the
tax has been deducted at higher rate.

Discontinuation of*“Y” type of correction statement.

FVU version 3.8 is applicablew.e.f 01/07/2013.

Key features 2.134
Key features of FVU 2.134 is as follows:

Addition of filler fields in:

o Deductor details (BH record)
o Challan details (CD record)
o Deductee details (DD record)

o Salary details (SD record). Applicable in case of 24Q, Q4.

Quarterly TDS/TCS statement (regular and correction) can be validated for statements pertaining to FY
2007-08 onwards.

Discontinuation of*“Y” type of correction statement.

FVU version 2.134 is applicablew.e.f 01/07/2013.

Enhancements in -- Version 13.3.10 -- Release Date 25/06/2013
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* Changes made in e-Payment of Challan 280, 281, 282 and 283 for AY population on e-Payment Screen on
website

Enhancements in -- Version 13.3.9 -- Release Date 24/06/2013

* Changes made in e-Payment of Challan 280, 281, 282 and 283
Enhancements in -- Version 13.3.8 -- Release Date 18/06/2013

* Added Form 26QB for Payment of TDS on Sale of Property with e-Payment option.
Enhancements in -- Version 13.3.7 -- Release Date 03/06/2013

* |n Form 16A (Traces S/w Format ) option given in verification tab whether print Annexure-I , Annexure-Il or
not.

Enhancements in -- Version 13.3.6 -- Release Date 25/05/2013

* Optimization done in generation AIR Return File for Revised.

* |n Report-> TDS Return Filing Status Report Modified.

* Optimization done for Form 27Q for large data above 5000 TDS Transaction (Option given at form opening
whether to Auto Load the data for default or selected quarter or to Load data manually by pressing the button
after selection.

* On Main Index under TDS Return Details 2 New Column Added as Correction Type and Remark.

Enhancements in -- Version 13.3.5 -- Release Date 21/05/2013

* Added Sahaj (ITR-1) for AY 2013-14 with Preview and Print
* Annual Information Return View Change from Vertical to Tab Based

Enhancements in -- Version 13.3.4 -- Release Date 07/05/2013
* NSDL Released FVU Version 3.71 on 06/05/2013 included in s/w.

Enhancements in -- Version 13.3.3 -- Release Date 04/05/2013

* Facility added to View the Certificate Form 16A Present in the text file downloaded from TRACES
website (Open Form 16A From TRACES from s/w). User have to import the Form 16A Text File
downloaded from the TRACES website. This Facility is only for the client conveyance to view the
different certificate present in the text file, however it is mandatory to issue the Certificate generated
from TRACES Tool only. If client is issuing the s/w generated Form 16A from FY 2011-12
onwards then it is his responsibility s/w will not responsible for it.

Enhancements in -- Version 13.3.2 -- Release Date 30/04/2013
* |n Form 16 from TRACES Verification Part can be edited now.
Enhancements in -- Version 13.3.1 -- Release Date 24/04/2013

* Added New File Validation Utility 3.7
* |n Form 49A and PAN Correction facility to Fill Online Form (master data will be auto populated in Form)

Enhancements in -- Version 13.3.0 -- Release Date 17/04/2013
* Facility to generate Form 16 from TRACES Text file of form 16. Procedure is as below
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1. Import the Form 16 Text File downloaded from TRACES website.
2. Part-B can be fill on button click for all generated certificated on the basis of PAN from AY 2013-14
onwards.
3. Facility to Bulk Export for generated certificate.
* Option given in Form 27A to take Preview / Print in Portrait (Vertical) format instead of Landscape format.
* New Form 27C Added
* Assessee Info Report column TRACES Login ID and Password Added.

Enhancements in -- Version 13.2.2 -- Release Date 08/04/2013
* Enhancement made in Form 15H
Enhancements in -- Version 13.2.1 -- Release Date 05/04/2013

* Enhancement made in Form 15G
* Added New Form 26B for TDS Refund.

Enhancements in -- Version 13.2.0 -- Release Date 23/03/2013

* Added New Form 15G and Form 15H
* Changes made in TDS CPC Quick link auto populating TAN in login on TRACES.
* Added Filter for "Filter by PAN Flag" in TDS Annexure for Revised

Enhancements in -- Version 13.1.4 -- Release Date 13/03/2013

* Changes made in TCS Certificate Form 27D. (added | - Tendu Leaves,J - Minerals and K - Bullion and
Jewellery in Nature of Payment Column)

Enhancements in -- Version 13.1.3 -- Release Date 02/03/2013

* Changes made in TDS CPC Quick Links due to Captcha inserted in TRACES Login screen.

Enhancements in -- Version 13.1.2 -- Release Date 26/02/2013
* Changes made in TDS CPC Quick Links for auto selecting FY, Quarter ..etc.
Enhancements in -- Version 13.1.1 -- Release Date 08/02/2013

* Changes made in Form 24Q Revised Return for Quarter-4 as the consolidate file downloaded from TRACES
is not in increasing order of Salary Detail Record Number.

Enhancements in -- Version 13.1.0 -- Release Date 05/02/2013

* Added New Field in Authorize Person Details ( PAN & DOB of Authorize Person)

* Auto Population Done from master date in New TAN Registration on TRACES.

* |n Deductee Details Master two button given one for only PAN Verification and other for PAN Verification with
updating Name as per PAN.

Enhancements in -- Version 13.0.4 -- Release Date 23/01/2013

* PAN Verification option added in Deductee Master Details . (PAN Verification done on the basis of deductor
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login on TRACES (www.tdscpc.gov.in)
Enhancements in -- Version 13.0.3 -- Release Date 18/01/2013
e Changes made in TAN Correction Form

e Modification done in e-TDS generation process. Once the Challan File of current date is downloaded and
saved in the folder where you will save the text file in e- TDS generation process it will never ask you for the
same & s/w will take it from that folder.

e Inform 24Q, 26Q, 27EQ and Form 27Q button given to Replace Special Character from Name of Deductee.
Enhancements in -- Version 13.0.2 -- Release Date 28/12/2012

e Changes made in Quick Links of TDS CPC for Auto Population of data for requesting consolidate file. Follow
the following steps

Enhancements in -- Version 13.0.1 -- Release Date 24/12/2012

e Changes made in Quick Links of TDS CPC for Auto Population of data for requesting consolidate file.
Follow the following steps

1. Open TDSCPC Quick Links

2. Select Request Consolidate File

3. After Login Select FY, Quarter & Form for which you want to request consolidate file
4. Click on “Go” button

5. For filling Challan Details of Challan & 3 Distinct PAN and Amount click on the button ’Fill From Stored
Data” it will fill data from the Assesse record for the respective quarter.

Enhancements in -- Version 13.0.0 -- Release Date 07/12/2012

e New Version for F.Y. 2013-2014

e Added New Form for TDS CPC Quick Links for the new TRACES ( www.tdscpc.gov.in )

Enhancements in -- Version 12.1.9 -- Release Date 29/11/2012
¢ Changes made in Know Your Name from PAN and Know Your PAN from Name link present in Tools menu.

e Option given in Form 27A to open Form 27A in Word.
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Enhancements in -- Version 12.1.8 -- Release Date 04/10/2012

Updated New File Validation Utility Version 3.6 & 2.133 applicable w.e.f. 16t Oct 2012

Updated TDS / TCS Chart for F.Y. 2012-2013

Changes made in Challan 281 (Added New Nature of Payment)

Changes made in Form 24Q, 26Q, 27Q & 27EQ as per the new FVU Version
Enhancements in -- Version 12.1.7 -- Release Date 24/07/2012
e Added Form 49AA

e Search Facility given in Form 24Q Salary Annexure along with filter for Name and PAN

Enhancements in -- Version 12.1.6 -- Release Date 22/06/2012
e Added New File Validation Utility 3.5
e Changes made in Know Your Name from PAN

e Added “e-TDS (Cancel Return)” button in Form 24Q,26Q,27EQ & 27Q in Revised for the
cancelation of Originally Submitted Return.

¢ In deductee detail master Button Added “Bulk Update Name from PAN” to update the
Name by verifying PAN from Name register under PAN in DIT.

Enhancements in -- Version 12.1.5 -- Release Date 31/05/2012

e Added Feature to Merge Form 16 Part-B Exported from S/w with Form 16 Part-A Generated from NSDL
PDF Generator. (Required Dot Net Framework 2.0 must be installed on machine.)

e You can now Export Only Part-B of the Form 16 also.
e Form 16 Part-A & Part-B merge utility will also work in Bulk. (Will Merge on the basis of PAN matching)
Enhancements in -- Version 12.1.4 -- Release Date 22/05/2012

e Correction in Form 24G- Name of DDO in DDO Transaction Details Restricted to 75 character, Address1,
Address2,Address3,Address4 & City in Transaction details restricted to 25 Character.

e Correction in Form 24Q- Tab Based View not showing properly in version 12.1.3
Enhancements in -- Version 12.1.3 -- Release Date 19/05/2012

¢ Employee Code (V - For Very Senior Citizen is added in Form 24Q Salary Annexure-ll for the
calculation of Tax of very senior citizen.

Enhancements in -- Version 12.1.2 -- Release Date 26/04/2012
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¢ Modification done in TDS Interest Calculation in Form 24Q,26Q,27Q & 27EQ where the income or amount
is credited or paid in the month of March

Enhancements in -- Version 12.1.1 -- Release Date 25/04/2012

e Added New File Validation Utility for Form 24G Version 1.2

Enhancements in -- Version 12.1.0 -- Release Date 18/04/2012

e Updated New PAN Correction Form

Enhancements in -- Version 12.0.7 -- Release Date 13/04/2012

e Added ITR-1, ITR-2 & ITR-3 for AY 2012-13

Enhancements in -- Version 12.0.6 -- Release Date 28/03/2012

e Form 27Q in Tab based mode along with Interest Calculation

Enhancements in -- Version 12.0.5 -- Release Date 20/03/2012
¢ Modification done in Interest Calculation on Form 26Q, 24Q, 27EQ

e Option given to View Form 26Q,24Q, 27EQ in Vertical Scrolling View instead of default
Tab based View.

Enhancements in -- Version 12.0.4 -- Release Date 16/03/2012
e Change in NSDL Quick Links form

e Form 24G and 27EQ changes in Tab based mode.

Enhancements in -- Version 12.0.3 -- Release Date 13/03/2012
e New FVU Version 3.4 and 2.132 included

e Form 26Q and 24Q look change in Tab based format with Interest Calculation (given for calculation
of Interest)

e Change in Master Assessee Index, Added Shortcut F2 to F12 on main index.
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Enhancements in -- Version 12.0.2 -- Release Date 20/01/2012

Updated Form 49A New : Added Name to be Printed on PAN Card in point 2, and
AADHAAR Number in point 12.

Changes made to generate 27A/27B in case of revised return so that Form will be
automatically fill after generating FVU File instead of generating Form 27A or Form 27B
from e-TDS File viewer.

Enhancements in -- Version 12.0.1 -- Release Date 14/01/2012

New File Validation Utility 3.3 and 2.131 included. Changes in New FVU Ultility is as
below

Key features of File Validation Utility VU) version 3.3

FVU 3.3 will be applicable for quarterlyTDS/TCS statements pertaining to FY 2010-11
onwards

Mandatory to quote Book Identification Number - BIN (in case of Regular statement) for
tax deposited by book entry (transfer voucher — applicable only in case ofGovt. Deductors).
BIN to contain details as below:

o Seven Digit 24G receipt number (provided on successful acceptance of Form 24G
statement at TIN central system)

o Five digitDDO serial no. (provided for each DDO transaction in Form 24G statement)

o Date of deposit of Tax

Correction file prepared to contain the “"Hash value” as per the consolidated file, used for
preparation of correction statement.
Mandatory to import consolidated file for validating correction statement.
For tax deducted at higher rate, if deductee PAN is valid, update allowed on all the fields of
the deductee record except, higher deduction flag (flag"C”) mentioned against the
corresponding deductee record.
FVU 3.3 will be mandatory with effectfrom February 01, 2012.
Files validated with FVU 3.2 and 3.3 will be allowed up to January 31, 2012,

Note:
BIN can be obtained by deductor (Drawing and Disbursing Officer) from the respective Pay and
Account Office (PAQ) / District Treasure Office (DTO).
BIN can also be downloaded by theDDO under the TAN account login.

Key features of File Validation Utility FVU) version 2.131

FVU 2.131 will be applicable forquarterly TDS/TCS statements (regular and correction)
pertaining up to FY 2009-10.

Correction file prepared to contain the “"Hash value” as per the consolidated file used for
preparation of correction statement.

Mandatory to import consolidated file for validating correction statement.
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FVU 2.131 will be mandatory with effect from February 01, 2012.
Files validated with FVU 2.130 and 2.131 will be allowed up to January 31, 2012.

Enhancements in -- Version 12.0.0 -- Release Date 15/12/2011

Release New Version for FY 2012-13

e TaxPro e-TDS Professional Version 11 Changes and Enhancements

Enhancements in -- Version 11.4.1 -- Release Date 26/11/2011

Excel Template Updated for Consolidate File changes

Enhancements in -- Version 11.4.0 -- Release Date 18/11/2011

Following changes made as per the changes in Consolidated File Format by NSDL

Deductee PAN valid flag: Flag will be provided for the deductee PAN, whether the same is valid or
invalid This will help the deductor know whether the PAN quoted in quarterly TDS/TCS statement is
valid. If the PAN is valid then value “Y” will be provided else value “N” will be provided. This flag will
be provided in deductee details and salary details.

PAN update counter: Update of PAN is allowed valid to valid only once. If the deductor attempts to
update the same again then i.e., exceeding the limit, then the respective deductee record is rejected
at TIN central system. In order to curb such rejection, will be provided in the consolidated file to
restrict the deductor from updating the deductee PAN, if the limit for update of deductee PAN been
reached.

Pending balance: There is a check at TIN central system wherein the deductor is not allowed to
utilize the tax deposit amount exceeding the challan deposit amount. If the deductor utilizes the
challan amount, more than the challan deposit then the respective statement is rejected. To curb
such rejection, pending balance amount against the respective matched challan will be provided in
the consolidated file.

Enhancements in -- Version 11.3.6 -- Release Date 26/08/2011

Enhancements in -- Version 11.3.5 -- Release Date 17/08/2011

Option to generate 27B for Form 27EQ for Revised

Changes made for revised for optimization.

Enhancements in -- Version 11.3.4 -- Release Date 2/08/2011

Added Assessee Information Report in Report Menu

Enhancements in -- Version 11.3.3 -- Release Date 22/07/2011

Added New Form, “Form No 12BA (Bulk)” under Salary Related option for the Bulk Generation of Form
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12BA

e Added Filter Option in TDS Annexure (For PAN and For Name) in Form 24Q, 26Q, 27EQ & 27Q

Enhancements in -- Version 11.3.2 -- Release Date 18/07/2011
e Added New Form — “NSDL Quick Link” under Online Services menu
¢ Added Validate Data button in Form 24Q and Form 26Q to validate the enter data.

e Added Login ID and Login Password field under “Authorized Person Details” required to maintain User ID
and Password for requesting TDS-TCS Consolidate file.

Enhancements in -- Version 11.3.1 -- Release Date 06/07/2011

e For Online TAN Registration (for NSDL consolidated TDS / TCS File) added New Form Online TAN
Registration in Forms menu.

e Enable Know Your Name from PAN facility

e Changes made in optimization in e-TDS File preparation from Form 26Q in case of large number of
transaction.

e Updated TaxPro TDS TCS Excel Template (version 11.0.1)

e Inform 3CD button given to copy data from previous year.

Enhancements in -- Version 11.3.0 -- Release Date 07/06/2011

e TDS/TCS correction statement to be prepared using consolidated TDS/TCS file only:
As directed by DIT (Systems), deductor/ collector are advised to prepare correction TDS/TCS statements
using consolidated TDS/TCS file only, provided by TIN. Consolidated TDS/TCS file is provided to registered
TANSs. For detailed procedure for registration of TAN and procuring consolidated TDS/TCS file - click here.

e Implemented the changes for revised as directed by DIT (Systems)
e Included ITR-1(Sahaj), ITR-2 and ITR-3 for AY 2011-12.

e New TDS-TCS Template for TDS Version 11.0.0 is updated
Enhancements in -- Version 11.2.2 -- Release Date 16/05/2011

e New Form 13 is Updated in the s/w.

Enhancements in -- Version 11.2.1 -- Release Date 29/04/2011
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. New NSDL File Validation Utility Version 3.2 Dated 29/04/2011 by NSDL is included in this version.
. Minor Changes made in New Form No 16
Enhancements in -- Version 11.2.0 -- Release Date 27/04/2011

e New Form 16 is added with auto fill from Form No 24Q provided Quarter 4 of Form 24Q is prepared.

Enhancements in -- Version 11.1.2 -- Release Date 05/04/2011
¢ Changes Made for Revised Return of Form 24Q, 26Q , 27EQ & 27Q

Enhancements in -- Version 11.1.1 -- Release Date 01/04/2011

Enhancements in -- Version 11.1.0 -- Release Date 29/03/2011
e New FVU Utility Version 3.1 for FY 2010-11 onwards & Version 2.130 up to FY 2009-10 included.

e Column 80CCEF is added in Form 24Q Salary Details as per the utility version 3.1.

Enhancements in -- Version 11.0.5 -- Release Date 09/03/2011
» Additional Validation made in preparing the e-TDS File
» Updated TaxPro Calc for FY 2011-2012.
Enhancements in -- Version 11.0.4 -- Release Date 28/01/2011
» Facility to include the Certificate Number in Bulk Export of Form 16A PDF Certificate
» New Modified TDS/TCS Excel Template for using in Form 24Q/26Q/27Q/27EQ is added.

Enhancements in -- Version 11.0.3 -- Release Date 10/12/2010
e Restriction made for Date on which Tax Deposited inChallan Details of Quarterly TDS Return. It
should not be blank. With the NSDL FVU Version 3.0 file is validating even if the date of
deposited is blank in case of nilchallan. But file is getting rejected after upload. In case of Nil

Challan entry please enter quarter end date. With this version onwards file will not be generated if
date of tax deposited is blank.

Enhancements in -- Version 11.0.2 -- Release Date 06/12/2010

e CIT Address Dropdown list given in Authorize Person Details on Main Index.

Enhancements in -- Version 11.0.1 -- Release Date 18/11/2010
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Enhancements in -- Version 11.0.0 -- Release Date 15/11/2010
e New Renewal Release Version 11.0.0

e This Version is backward compatible i.e. if you have license up to FY 2010-11 then also you can download
this version and work up to your License Financial Year as per license.

e Added TDS/ TCS Chart for Salary , Non Salary & TCS for FY 2010-11

TaxPro e-TDS Professional Old Version 10 Changes and
Enhancements

Enhancements in -- Version 10.6.5-- Release Date 29/10/2010

e Added Facility to View the Certificate Register in New Form No. 16A & Form No. 27D with Print, Preview &
Export to Excel Facility

Enhancements in -- Version 10.6.4-- Release Date 22/10/2010
e Fix the Error getting in generating Form 27D from Form 27EQ in version 10.6.3
Enhancements in -- Version 10.6.3-- Release Date 18/10/2010

e Option given whether to generate certificate from Original or Revised in Form 16A New also added button to
delete the selected certificate.

e Added New AIR File Validation Utility
Enhancements in -- Version 10.6.2-- Release Date 11/10/2010

e Changes made for Revised Quarterly TDS / TCS Return as per New NSDL Data Structure for FVU Version
2.129 & 3.0 . (Removed the Restriction of Email, Phone, Mobile No. from Revised Return before creating
the File because it will take the values as per the original or previously filed return of respective quarter. )

Enhancements in -- Version 10.6.1-- Release Date 08/10/2010

e Changes made for Revised Quarterly TDS Return as per new NSDL Data Structure.

Enhancements in -- Version 10.6.0-- Release Date 06/10/2010

¢ New File Validation Utility Version 2.129 for Validating the Quarterly TDS Return up to FY. 2009-2010 is
added.

¢ New File Validation Utility Version 3.0 for Validating the Quarterly TDS Return from FY. 2010-2011
onwards is added.

e Form 24G added with File Validation Utility Version 1.0

e Added New Field in Authorize Person Details on Main Index
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e Added New TDS Template "Taxpro TDS-TCS Excel Template.xIt" in your Program Folder with inbuilt
validation.

Enhancements in -- Version 10.5.0-- Release Date 04/09/2010
¢ Added Procedure for Revised e-TDS & FAQ on Form 24Q, 26Q, 27Q and 27EQ
e Added Firm Registration Number option in Form 3CD, 3CB, 3CA
Enhancements in -- Version 10.4.0-- Release Date 19/08/2010

e Changes made for Receipt No. in TDS / TCSCertificate as per the NSDL Clarification

e Receipt number to be quoted in Form 16/16A will be generated by TIN. Receipt number will be
generated for the quarterly TDS/TCS statements pertaining to FY 2010-11 and onwards uploaded
to TIN. Receipt number generated will be of eight digits (alphabets) and will be applicable only for
statements pertaining to FY 2010-11 and onwards. Eight digit receipt number can be obtained by
viewing the status of the quarterlyTDS/TCS statement at under Quarterly Statement Status feature

available at TIN website (www.tin-nsdl.com).

Receipt number provided by TIN is in addition to the provisional receipt number provided on

acceptance/upload of quarterly TDS/TCS statement. Provisional receipt number will be referred as

Token no for the statements pertaining to FY 2010-11 and onwards.

Enhancements in -- Version 10.3.2-- Release Date 10/08/2010
e Option Added in New Form 16A & Form 27D to Auto Fill Address from the Return.
e Facility to Export the TDS / TCS Certificate in PDF.

Enhancements in -- Version 10.3.1-- Release Date 30/07/2010

e Changes made in generating Form 16A from 27Q

Enhancements in -- Version 10.3.0-- Release Date 28/07/2010

e Added Form 27D New (TCS Certificate) for FY 2010-2011
Enhancements in -- Version 10.2.1-- Release Date 26/07/2010

e Added option to print Notes in Form 16A New for FY 2010-2011
Enhancements in -- Version 10.2.0-- Release Date 24/07/2010

¢ New Form 16A for FY 2010-2011 is added. Other enhanced Features will be available soon.
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Enhancements in -- Version 10.1.7-- Release Date 22/05/2010
e In Challan 280, 281, 282 Tel. No. field Added

e Changes made in ITR2, ITR-3 for AY 2010-2011 Max Date of Payment / Deduction set to 31/03/2010 in
Schedule TDS /TCS

Enhancements in -- Version 10.1.6-- Release Date 22/05/2010

e Added New Saral-ll, ITR-1 and ITR-2 are added.
Enhancements in -- Version 10.1.5-- Release Date 12/05/2010

¢ In AIR Return Facility to Check Invalid PAN Entry

e Changes made in Bulk Export option of Certificate.
Enhancements in -- Version 10.1.4-- Release Date 08/05/2010

e Added New Saral-Il for AY 2010-2011
Enhancements in -- Version 10.1.3-- Release Date 22/04/2010

e Added AIR (Annual Information Return) for FY 2009-2010
Enhancements in -- Version 10.1.2-- Release Date 01/04/2010

¢ Changes made to "Get Name from PAN" added in Tools menu of TaxPro e-TDS Professional as from new
FY 2010-2011 in previous version it was not working.

Enhancements in -- Version 10.1.1-- Release Date 18/03/2010

e Facility given to " Get Name from PAN" added in Tools menu of TaxPro e-TDS Professional (Required Net
Connected)

e Facility given on Assessee Index to "Update Name of selected Assessee as per the PAN (provided PAN
is valid )" (Required Net Connected)

e Facility while Adding New Assessee, after enter the PAN, Assessee Name will auto populate. (Required Net
Connected)

e In Deductee Master, button given to Update Name as per the PAN. (Required Net Connected)
Enhancements in -- Version 10.1.0-- Release Date 22/02/2010

e Added Annexure-| to Annexure IV in Form 10E

e Changes made in TDS Return Status Report in Report menu.
Enhancements in -- Version 10.0.2-- Release Date 10/12/2009

e Changes made in Form 15CA & 15CB.
Enhancements in -- Version 10.0.1-- Release Date 25/11/2009

e Max length set for each field in Form No. 15CA.
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e In Form No. 16 Corporate "Fill from 24Q" button was not visible in previous version, it has been modified.
Enhancements in -- Version 10.0.0-- Release Date 06/11/2009

e TaxPro e-TDS Professional Renewal for F.Y. 2010-2011
Enhancements in -- Version 9.4.3-- Release Date 22/10/2009

¢ If PAO Code Not available for Govt. Deductor write PAOCDNOTAVBL

e |f DDO Code Not available for Govt. Deductor write DDOCDNOTAVBL

e In TaxPro Calc added TDS Calculater only for the License User of TaxPro e-TDS Professional & TaxPro
e-TDS Corporate s/w.

e TaxPro CAlc can be install from the Link http://www.taxpro.co.in/downloads/TPCalc.exe

Enhancements in -- Version 9.4.2-- Release Date 13/10/2009

e Button given to download the Challan Input File from the NSDL website in 24Q, 26Q, 27Q & 27EQ. Also
link given for the same in Tools menu.

e New features in FVU 2.128 given for the user help in each form.
Enhancements in -- Version 9.4.1-- Release Date 03/10/2009
e Changes made for Nil Return as per the New Data Structure.
Enhancements in -- Version 9.4.0-- Release Date 01/10/2009
e New TDS File Validation Utility 2.128 is included with New File Format for Quarterly Return.
e New AIR File Validation Utility 1.4.5 Included .

e Additional Fields added in 24Q, 26Q, 27Q, 27EQ as well as in Authorised Person details on Main Index for
Ministry Name, PAO/DDO Code, PAO/DDO Registration Number,

Enhancements in -- Version 9.3.2-- Release Date 27/08/2009
e Added facility to Import FVU file Excel Template for Form 24Q, 26Q, 27Q & 27EQ
e Added Button of Upload Online in Form 15CA

Enhancements in -- Version 9.3.1-- Release Date 19/08/2009
e Changes made in Form 15CB

Enhancements in -- Version 9.3.0-- Release Date 10/08/2009

e Given TDS Return Details option on Assessee Index to manage the Return Status along with Return Date &
Acknowledgement No. Return Status Indicator will be highlighted as per this details.

e Facility to print certificate for Selected Month under Bulk Print option.
e ITR-7 for AY 2009-10 is added.
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e New Form 15CA & Form 15CB is added under e-TDS menu

e In Form 24Q, 26Q, 27Q & 27EQ on right click of mouse button on TDS/TCS Annexure following option
given

e a. Show Only Invalid PAN Rows (It will show all the entries where PAN is not structurally Valid as per NSDL
Validation.

e b. Show All Rows

e c. Mark Invalid Entries with Red (This will mark those entries where TDS + SC + Edu.Cess. is not match
with Total Tax Deducted with Red color)

d. Show Invalid Entries only (This will show only all those entries where TDS + SC + Edu.Cess. is not
match with Total Tax Deducted with Red color)

Enhancements in -- Version 9.2.2-- Release Date 29/07/2009

e Option given whether to Load Current F.Y. or Previous F.Y. at the startup of application.

¢ Added Residential Address Fields on Assessee Index.
Enhancements in -- Version 9.2.1-- Release Date 23/07/2009

o Changes for Annual Certificate generation of Form 16A from Original & Revised Return.
Enhancements in -- Version 9.2.0-- Release Date 22/07/2009

e Most awaited features to Prepare Form 16A from Original Return as well as Revised Return is available
now. (provided both Original & Revised Return are saved in Form 26Q)

e Certificate Register of Generated Form 16A from 26Q can be maintain with status of certificate as Prepared
& Issued along with manually given Certificate No.

e InForm 26Q, Form 24Q, Form 27Q and Form 27EQ additional column for Interest & Others is added in
Challan Details Table. (This is for if in any challan containing Interest Amount present in that Quarter and it
is already utilized in previous quarter in that case in 2nd Interest Column write 0. Also Updated the Excel
Template for the same

e Form 16A can also be generated for selected month only.
Enhancements in -- Version 9.1.10-- Release Date 22/06/2009

e In Form 16 Corporate added support to give TDS details maximum up to 20 Records previously it was only
15 Rows.

Enhancements in -- Version 9.1.9-- Release Date 09/06/2009
e Inform 3CD point 17A is newly added as per the notification.
Enhancements in -- Version 9.1.8-- Release Date 02/06/2009

e Option given at the time of preparing the Certificate from 26Q, 27Q & 27EQ to Fill the Address from Master
Details on the basis of Valid PAN.
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e Optimize the Form 26Q for Faster Loading of Data in case of large number of Transaction .
Enhancements in -- Version 9.1.7-- Release Date 25/05/2009

e Facility given to prepare Form 16A From Form 27Q.
Enhancements in -- Version 9.1.6-- Release Date 14/05/2009

e Added PAN, Name List in Salary Details Annexure -l of 24Q

e Employee Name Column added in Chapter VI-A details of Form 24Q - Quarter 4
Enhancements in -- Version 9.1.5-- Release Date 29/04/2009

e Form ITR-1, ITR-2 and ITR-3 updated for A.Y. 2009-10
Enhancements in -- Version 9.1.4-- Release Date 27/04/2009

e AIRfor F.Y. 2008-2009 is updated.

e Facility to Insert or Delete Bulk Row in Form 24Q
Enhancements in -- Version 9.1.3-- Release Date 20/04/2009

e Updated New File Validation Utility 2.126 (applicable only for the Quarterly Return upto F.Y. 2008-09 only)
Enhancements in -- Version 9.1.2-- Release Date 07/04/2009

e Changes Auto Tax Calculation in Annexure-ll Salary Details of Form 24Q - Quarter 4
Enhancements in -- Version 9.1.1-- Release Date 31/03/2009

e Auto Tax Calculation in Annexure-Il Salary Details of Form 24Q - Quarter 4

e Correction in Form 10B
Enhancements in -- Version 9.1.0-- Release Date 10/02/2009

e Added Form 10A and Form 10B under Forms -> Audit forms menu.

e Facility to print the Form 49A in Box Format. Check the option Print in Box Format given on Form 49A.

e Facility to Show the Percentage of Structurally Valid PAN % in Original Return. Use the button "Check
Invalid Employee PAN" button to recalculate the ratio.

Enhancements in -- Version 9.0.0-- Release Date 24/11/2008

¢ Released TaxPro Form New Version for F. Y. 2009-10 with New Look.
Enhancements in -- Version 8.7.4-- Release Date 11/10/2008

e Option added under Tools menu to Know Your TAN from Name Or TAN

e Enhancement in Revised for C1 (Correction in Deductor Details ) type Correction
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Enhancements in -- Version 8.7.3-- Release Date 02/10/2008
e Option added under Tools menu to Know Your PAN from Name and Date Of Birth
Enhancements in -- Version 8.7.2-- Release Date 23/09/2008
e Deductee Search facility given on Deductee Details
e PAN & TAN Validation on Assessee Index as well as in e- TDS Form as per NSDL File Validation Utility.

e In Form 24Q, 26Q, 27EQ button "Check Invalid Employee / Deductee Party PAN" is given below the TDS
Table. This will be useful to check structurally Invalid PAN as per NSDL File Validation Utility

e Enhancement in 26Q Revised return to avoid rounding difference where TDS amount is in fraction. This is
to minimize the Sum mismatch error if any due to rounding difference.

e BSR Code of Bank updated in TaxPro BSR and MICR Coder search utility as per BSR Coder available on
NSDL website

¢ No need to keep the temp data folder in C:\TaxPro on client machine in case of LAN version or if Database
folder is other than on C drive.. Previously getting massage while opening Challan Details Register, Form
Status Report if temporary C:\TaxPro\Data folder not found.

Enhancements in -- Version 8.7.1-- Release Date 28/08/2008

e If AIR Excel Template Contains District Code instead of District Name it will also import and generate the
File correctly.

e Correction In AIR Revised Return in case of Filing Revised return for Originally File Nil Return. (Previously
getting massage "13 Type Mismatch" at the time of generating the file)

Enhancements in -- Version 8.7.0-- Release Date 24/08/2008

e Fix the issue in e-Payment of Challan getting massage as "HTTP method GET is not supported by this
URL".

e Included New AIR File Validation Utility 1.4.4
e STD Code & E-Mail ID Field added on Assessee Index

e Facility to give TDS Authority Details on Assessee Index ( This will fill up automatically Person Responsible
Details for e-TDS Return)

Enhancements in -- Version 8.6.7-- Release Date 18/07/2008
e Included New AIR File Validation Utility 1.4.3
Enhancements in -- Version 8.6.6-- Release Date 12/07/2008

. Option given to Set / Change Password for Assessee Deletion so that no one can delete the
Assessee without password.

Enhancements in -- Version 8.6.5-- Release Date 10/07/2008

. Facility to export the separate file of each certificate ipdf format using Bulk Export button. For
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Example. If Number of deductees are 100 then 100 pdf file will be created on given path by using
Bulk Export button.

Enhancements in -- Version 8.6.4-- Release Date 04/07/2008
. Challan will be filled automatically on just button Click for "e-Payment" .

. Change in order Sequence in Revised Return in Case of Multiple Batches previously sequence
C1, C5, C3, C2... it has been change to sequence C1, C2, C5, C3...

Enhancements in -- Version 8.6.2 -- Release Date 03/06/2008
. Facility for Inserting and Deleting Bulk Row in Form No.26QTDS Details Table
. Enhancements in Generating Certificate in case of Name including Apostrophes
Enhancements in -- Version 8.6.1 -- Release Date 19/05/2008
Enhancements in -- Version 8.6.0 -- Release Date 15/05/2008
Enhancements in -- Version 8.5.7 -- Release Date 09/05/2008
. Changes made for Revised Return for 27EQ

Enhancements in -- Version 8.5.6 -- Release Date 06/05/2008
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